
Equity Derivatives

Monthly Update

Markets Division

Information for institutional and corporate investors’ reference only

December 2022



Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures
CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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As at 30 December 2022

Equity Indices Monthly Performance in

3

December 2022

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Equity Index Futures Access Codes

+4.0%

+5.2%

+6.4%

HS Mainland
Banks Index

HSCEI

HSI

% Change

Index Name

+0.9%

+2.2%

+3.2%

+3.4%

+5.2%

CSI 300 Index

MSCI China A
50 Connect

Index

CES120 Index

FTSE A50 Index

HSCEI

% Change

Index Name

Vendor HS Mainland Banks CES 120 HSI HSCEI

Bloomberg BMWA CESA HIA HCA

Refinitiv 0#HMBI: 0#HCHH: 0#HSI: 0#HCEI:

WIND MBIF CHHF HSIF HHIF

ET Net MBI CHH HSI HHI

Data Source: Bloomberg

Information for reference only



Hang Seng Index (HSI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

HSI Futures (YoY) HSI Options (YoY)

HSI Futures (MoM) HSI Options (MoM)

As at 30 December 2022
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HSI Products

(2022 vs 2021)
ADV OI*

HSI Futures 152,374 (+10%) 114,218 (-5%)

Mini-HSI Futures 107,851 (+8%) 11,822 (-28%)

HSI Options 25,832 (-2%) 108,323 (+32%)

Mini-HSI Options 12,467 (+12%) 13,454 (+17%)

HSI Futures

Options
2,602 (+1856%) 52,653 (+887%)

HSI Volatility

Index Futures
0 (-) 0 (-)

HSI Dividend

Point Index

Futures

29 (-3%) 321 (-38%)



HSI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 December 2022

Hang Seng Index

 Includes the largest and most

 liquid stocks listed in Hong Kong

 Index Level  19,781.41 (As at 30 Dec 2022)

 Index Volatility (30-Day Historical)  29.9

 Index Avg. Day High-Low Range  334.27 (Dec 2022)

 HSCEI Correlation (2022)  0.989

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.99Mn (As at 30 Dec 2022)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 28 Dec 2022  HK$78,150

Hang Seng Index Futures

 Index Description

HSI & Top 5 Constituents

Distribution of HSI Index Options OI in Month-end
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Hang Seng China Enterprises Index (HSCEI) Futures & Options

Equity Index Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 30 December 2022

HSCEI Futures (YoY) HSCEI Options (YoY)

HSCEI Futures (MoM) HSCEI Options (MoM)
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(No. of Contracts)

HSCEI Products

(2022 vs 2021)
ADV OI*

HSCEI Futures 183,068 (+43%) 609,987 (+72%)

Mini HSCEI

Futures
13,615 (0%) 5,085 (-27%)

HSCEI Options 45,043 (0%) 1,147,559 (+16%)

Mini HSCEI

Options
3,498 (+108%) 27,934 (+244%)

HSCEI Futures

Options
19,467 (+1330%) 736,779 (+768%)

HSCEI Dividend

Point Index

Futures

1,362 (+16%) 57,469 (+8%)



HSCEI Futures & Options

Equity Index Futures & Options
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Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 December 2022

HSCEI & Top 5 Constituents
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HSCEI

Comprises the largest and

most liquid H shares

 Index Level  6,704.94 (As at 30 Dec 2022)

 Index Volatility (30-Day Historical)  34.8

 Index Avg. Day High-Low Range  132.58 (Dec 2022)

 Correlation with HSI, CES120 (2022)  0.989,0.95

 Correlation with CSI300, FTSE A50

 (2022)
 0.775,0.797

 Contract Multiplier HK$50

 Notional Value (1 Contract)  HK$0.34Mn (As at 30 Dec 2022)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Margin as of 28 Dec 2022  HK$30,450

HSCEI Futures

 Index Description

HSI vs HSCEI 

Distribution of HSCEI Index Options OI in Month-end



Weekly HSI & HSCEI Options Performance
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Data Source: HKEX

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 December 2022

An investment tool to manage short term event risk

Weekly HSI & HSCEI Options Volume
Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven,

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$10 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Contract Multiplier  HK$50

Liquidity Providers
 Akuna, Eclipse, I-Access, IMC, Maven,

Optiver

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$3.5 / contract

SFC Levy  HK$0.54 / contract

Commission Rate  Negotiable

Weekly HSI Options

Weekly HSCEI Options
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Single Stock Futures & Options

Equity Futures & Options
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Data Source: HKEX

* OI compared to previous year-end

Information for reference only

As at 30 December 2022

Stock Options (YoY)Stock Futures (YoY)

No. of Single Stock Derivatives

Single Stock Futures 98

Single Stock Options 124

Stock Futures

• Products

 3 A-shares ETFs futures contracts

 Total 98 stock futures contracts

Latest and Future Developments

Stock Options

• Products

 3 A-shares ETFs options contracts

 Total 124 stock options contracts

• Market Makers (MMs)

 3 types of market makers (PMM/ CQMM/ 

QRMM)

 CQMM to provide 50 series continuous 

quotations

Stock Futures (MoM) Stock Options (MoM)
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Single Stock Derivatives ADV (2022 vs 2021) ADV OI*

Stock Futures 7,816 (-19%) 33,966 (+16%)

Stock Options 587,749 (-8%) 7,731,787 (-3%)



Hang Seng TECH Index Futures and Options Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 30 December 2022

Volume and Open Interest continue to growth
Providing investors with a tool to manage their risk exposure 

to Hong Kong-listed technology companies

Tracks the largest technology companies

listed in Hong Kong

Hang Seng TECH Index Futures & Options & Futures Options

Contract Multiplier HK$50 per index point

Notional Value (1 Contract) HK$206K (As at 30 December 2022)

No. of Liquidity Providers Options: 5

Transaction Cost*

Stamp Duty  N/A

Trading Fee  HK$5.00 / contract

SFC Levy  HK$0.54 / contract

Hang Seng TECH Index

Index Description
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MSCI China A 50 Connect Index Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 30 December 2022

Risk management tool for diversified China portfoliosSector-balanced exposure to China’s A-share market

 MSCI China A 50 Connect Index

 Balanced representation from 11 sectors

 of top 50 China A shares

 Index Level  2,169.77 (As at 30 December 2022)

 Index Volatility (30-Day Historical)  21.2

 Index Avg. Day High-Low Range  19.54 (December 2022)

 CSI300 Correlation (2022)  0.977

 FTSE A50 Correlation (2022)  0.977

 Contract Multiplier  US$25

 Notional Value (1 Contract)  US$0.05Mn (As at 30 December 2022)

 Average Quote Size  US$0.27Mn (5 Contracts)

Transaction Cost*

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 28 Dec 2022  US$3,120

 MSCI China A 50 Connect Index Futures

 Index Description

Average Daily Volume (as of December 2022)

Open Interest (as of 30 December 2022)
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MSCI Asia and Emerging Market Index Futures Performance
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Data Source: HKEX

* Exclude commission fees

Information for reference only

As at 30 December 2022

Volume and Open Interest continue to growth
HKEX with the broadest suite of MSCI derivatives products 

based in the Asian time-zone
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ADV

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier Average US$40

Notional Value (1 Contract) Average US$44K (As at 30 December 2022)

No. of Liquidity Providers 12

Transaction Cost*

Stamp Duty  N/A

Trading Fee  US$0.6-US$1.0 / contract

SFC Levy  US$0.07 / contract

MSCI Asia and Emerging Market Index

Index Description

Open Interest (As of 30 December 2022)

Average Daily Volume (As of December 2022)



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance
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Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference only

As at 30 December 2022

MSCI AxJ Combines Developed and Emerging Markets (Rebased  to 100)

MSCI AxJ is a well-established benchmark representing Asia 

regional (excluding Japan) equity market performance
Futures contracts have relatively lower transaction costs
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 MSCI AxJ

representation 2 DM countries (excl. Japan)

and 9 EM countries in Asia

 Index Level  411.07 (As at 30 December 2022)

 Index Volatility (30-Day Historical)  19.1

 Index Avg. Day High-Low Range  6.63 (December 2022)

 HSI Correlation (2022)  0.931

 HSCEI Correlation (2022)  0.918

 Contract Multiplier  US$100

 Notional Value (1 Contract)  US$41K (As at 30 December 2022)

 Avg. Quote Size  US$0.21Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  1.2 index points (December 2022)

 Liquidity Providers Flow  and 11 banks

Stamp Duty  N/A

Trading Fee  US$0.5 / contract

SFC Levy  US$0.07 / contract

Margin as of 28 Dec 2022  US$2,960

 Transaction Cost*

 MSCI AxJ Futures

 Index Description
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Hang Seng Mainland Banks Index Futures Performance
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 December 2022

Index & Constituents 3-Month Performance (Rebased to 100)

HSMBI Futures can be used for hedgingFutures contracts have relatively lower transaction costs

 Hang Seng Mainland Banks Index (HSMBI)

 10 largest and most representative 

 HKEX-listed mainland banks stocks

 Index Level  2,510.26 (As at 30 December 2022)

 Index Volatility (30-Day Historical)  20.5

 Index Avg. Day High-Low Range  26.27 (December 2022)

 HSI Correlation (2022)  0.744

 HSCEI Correlation (2022)  0.722

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.13Mn (As at 30 December 2022)

 Avg. Quote Size  HK$0.63Mn (5 Contracts)

 Avg. Bid-Ask Trading Spread  N/A

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$2 / contract

SFC Levy  HK$0.54 / contract

Margin as of 28 Dec 2022  HK$6,400

Transaction Cost*

 Hang Seng Mainland Banks Index Futures

 Index Description

0.22%

0.26%

0.27%

0.31%

0.32%

0.39%

0.39%

0.42%

0.43%

0.53%

N/A

CM Bank 3968.HK

ICBC 1398.HK

CCB 939.HK

PSBC 1658.HK

CITIC Bank 998.HK

ABC 1288.HK

Bank of China 3988.HK

CEB Bank 6818.HK

Minsheng Bank 1988.HK

Bankcomm 3328.HK

HSMBI Futures

90

100

110

120

Oct-2022 Nov-2022 Dec-2022

HSMBI CCB (939.HK)

ICBC (1398.HK) BOC (3988.HK)

ABC (1288.HK)

5-Min Avg. Bid-Ask Spreads (30 December 2022)
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Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference only

As at 30 December 2022

0.12%

0.16%

0.25%

N/A

X iShares A50 ETF (2823.HK)

CSOP FTSE A50 ETF (2822.HK)

ChinaAMC CSI300 ETF (3188.HK)

CES120 Futures

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

5-Min Avg. Bid-Ask Spreads (30 December 2022)

70

80

90

100

110

120

130

140

150

Oct-2022 Nov-2022 Dec-2022

CES120 Index Tencent CCB

Ping An China Mobile

 CES120 Index

 80 A-Shares and 40 HK-listed Mainland

 China H-shares, P-chips, and red chips

 Index Level  5,658.64 (As at 30 December 2022)

 Index Volatility (30-Day Historical)  24.7

 Index Avg. Day High-Low Range  77.35 (December 2022)

 CSI300 Correlation (2022)  0.904

 FTSE A50 Correlation (2022)  0.921

 Contract Multiplier  HK$50

 Notional Value (1 Contract)  HK$0.28Mn (As at 30 December 2022)

 Average Quote Size  HK$1.41Mn (5 Contracts)

 Average Bid-Ask Trading Spread  N/A

 Liquidity Providers  N/A

Stamp Duty  N/A

Trading Fee  HK$5 / contract

SFC Levy  HK$0.54 / contract

Margin as of 28 Dec 2022  HK$16,200

 CES120 Index Futures

 Index Description

Transaction Cost*
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Data Source: HKEX

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTI/<yy><m>.HF HTI/<yy><mm>/<strike><t>.HF

Bloomberg L.P. HCTA Index HSTECH Index OMON

Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DZH HTI

East Money 

Information

HTI

ESunny Information HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv 0#HHTI 0#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK



MSCI China A 50 Connect Index Futures Access Codes

17

Data Source: HKEX

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790

ACTIV Financial MCA/<yy><m>.HF

Bloomberg L.P. MCYA Index

Colt Technology MCAmy

East Money Information MCA

ESunny Information MCA

ETNet MCA

Infocast Ltd MCA

N2N-AFE 870939

Refinitiv 0#HMCA:

SIX Financial MCAmy

Wind MCAF.HK



MSCI Asia and Emerging Market Index Futures Access Codes
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Data Source: HKEX

Information 

Vendor

MSCI 

Australia 

NTR (USD) 

Index 

Futures

MSCI China A 

50 Connect 

(USD) Index 

Futures

MSCI 

China 

(USD) 

Index 

Futures

MSCI China 

Free (USD) 

Index 

Futures

MSCI China 

NTR (USD) 

Index 

Futures

MSCI China 

Free NTR 

(USD) Index 

Futures

MSCI EM 

Asia ex 

China NTR 

(USD) Index 

Futures

MSCI EM 

Asia ex 

Korea NTR 

(USD) Index 

Futures

MSCI EM 

Asia NTR 

(USD) Index 

Futures

MSCI EM 

EMEA NTR 

(USD) Index 

Futures

MSCI EM ex 

China NTR 

(USD) Index 

Futures

Bloomberg HKCA Index MCYA Index CSIA Index HMSA Index CJEA Index HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index

Refinitiv 0#HMAN: 0#HMCA: 0#HCHI: 0#HMCU: 0#HCHN: 0#HMCN: 0#HMAC: 0#HMAK: 0#HEAN: 0#HMEE: 0#HMXC:

WIND MANF.HK MCAF.HK MCNF.HK EANF.HK

Information 

Vendor

MSCI EM ex 

Korea NTR 

(USD) Index 

Futures

MSCI EM 

LatAm NTR 

(USD) Index 

Futures

MSCI 

Emerging 

Markets (USD) 

Index Futures

MSCI 

Emerging 

Markets NTR 

(USD) Index 

Futures

MSCI Hong 

Kong NTR 

(USD) Index 

Futures

MSCI India 

(USD) Index 

Futures

MSCI India 

NTR (USD) 

Index Futures

MSCI 

Indonesia 

Index (USD) 

Futures

MSCI 

Indonesia NTR 

(USD) Index 

Futures

MSCI Japan

(JPY) Index 

Futures

Bloomberg HQIA Index HQYA Index HMPA Index HMOA Index HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index

Refinitiv 0#HMXK: 0#HMEL: 0#HMEM: 0#HEMN: 0#HMHN: 0#HMDA: 0#HMIN: 0#HMID: 0#HMDN: 0#HMJP:

WIND MINF.HK MDNF.HK

Information 

Vendor

MSCI Japan 

NTR (JPY) 

Index Futures

MSCI Japan 

NTR (USD) 

Index Futures

MSCI Malaysia 

(USD) Index 

Futures

MSCI Malaysia 

NTR (USD) 

Index Futures

MSCI New 

Zealand NTR 

(USD) Index 

Futures

MSCI Pacific 

ex Japan NTR 

(USD) Index 

Futures

MSCI Pacific 

NTR (USD) 

Index Futures

MSCI 

Philippines 

(USD) Index 

Futures

MSCI 

Philippines 

NTR (USD) 

Index Futures

MSCI 

Singapore 

Free (SGD) 

Index Futures

Bloomberg HQBA Index HJCA Index HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index HNSA Index HLEA Index HKOA Index

Refinitiv 0#HMJJ: 0#HMJU: 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG:

WIND MJUF.HK MMNF.HK

Information 

Vendor

MSCI 

Singapore 

Free NTR 

(USD) Index 

Futures

MSCI 

Singapore 

NTR (USD) 

Index Futures

MSCI Taiwan 

(USD) Index 

Futures

MSCI Taiwan 

25/50 (USD) 

Index Futures

MSCI Taiwan 

25/50 NTR 

(USD) Index 

Futures

MSCI Taiwan 

NTR (USD) 

Index Futures

MSCI Thailand 

(USD) Index 

Futures

MSCI Thailand 

NTR (USD) 

Index Futures

MSCI Vietnam 

(USD) Index 

Futures

MSCI Vietnam 

NTR (USD) 

Index Futures

Bloomberg HOBA Index HKPA Index HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index

Refinitiv 0#HMGN: 0#HMSN: 0#HMTW: 0#HTWP: 0#HTWN: 0#HMWN: 0#HMTH: 0#HMTN: 0#HMVT: 0#HMVN:

WIND MTWF.HK MWNF.HK MTNF.HK



Weekly HSI and HSCEI Options Access Codes
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Data Source: HKEX

MSCI AxJ and MSCI AxJ Futures Access Codes

Information Vendor Weekly HSI Options Weekly HSCEI Options

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name

Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <0#HSIW*.HF> <0#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

Hong Kong and International Information Vendors

Information Vendor MSCI AxJ Index MSCI AxJ Index Futures

AASTOCKS - 221495

Activ Financial - MXJ/<yy><m>.HF

Bloomberg M1ASJ Index MJSA Index CT

CQG - MXJ

DB Power - MXJ

East Money Information - MXJ

Factset - MXJE

ICE Data Services - F:MXJ

Infocast - MXJ

N2N-AFE - 870823

QPWeb - P11203

SIX Financial Information - MXJmy

Refinitiv .MIAX00000NUS 0#HMXJ:

Telequote Data - MXJ/<yy><m>.HF

Tele-Trend - MXJFC, MXJmyy

Hong Kong and International Information Vendors



Sector Index and Sector Index Futures Access Codes
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Data Source: HKEX

Information Vendor Mainland Banks 

Index

Mainland Banks 

Index Futures

AASTOCKS 221420

Activ Financial =0200700.HK MBI/16K.HF

AFE 837451 870809

Bloomberg HSMBI Index BMWA Index

DB Power MBI

ET Net MBN MBI

Infocast HSMBI MBI

QuotePower SEHK.HHSMBI P11223

Telequote MBImy

Refinitiv .HSMBI 0#HMBI:

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor Mainland 

Banks Index

Mainland Banks 

Index Futures

East Money HSMBI MBI

Hexin Flush Financial MBIC

Pobo Financial MBI+Month+Year

Qianlong 999905 209

Wind HSMBI MBIF+yymm+HK



CES120 Index and CES120 Index Futures Access Codes
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Data Source: HKEX

Information Vendor CES 120 Index CES 120 Index Futures

Bloomberg Finance L.P. CES120 CESA Index DES <GO>

Refinitiv .HKCES120 0#HCHH:

AAStocks.com Limited 110056 221360

AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH

Infocast Limited CE120 CHH

Interactive Data Group I:CES120 Fn:CHH\MYYDD

Marketprizm Hong Kong Limited CES120 CHHmy

SIX Financial Information Ltd. CES120 CHHmy

Telequote Data International Limited CES120 CHHmy

Hong Kong and International Information Vendors

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code

Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK

Zheng Zhou Esunny Information Technology Co, 

Ltd.
- CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209


